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This is the main index for WinStorm.



What is WinStorm?
Welcome to WinStorm ... the hurricane tracking program for MS Windows.    Intended for the most 
part to be used to track the position, intensity and general motion of active storms, WinStorm 
also provides a complete historical database of NOAA storm track data for use in observing 
seasonal and periodic trends and patterns of cyclonic storm development and behavior.

In WinStorm, storm data for a given storm is stored in a single file, otherwise known as a log.    
Each record within a log describes the storm's location, intensity, direction, etc., for a particular 
date and time.    A record typically corresponds to a weather service update of the status of a 
storm.

Storm logs may be created, viewed, and edited via the Log editor.    The log editor becomes active
after you have selected either the New or Open options from the File menu to begin a new log or 
to open an existing one.    Once active, you may then open the Log editor by clicking on the Log 
option on the menu bar. To save any changes that you make within the Log editor, use the Save 
or Save As options on the File menu.

To generate a storm track on the map, you must have either loaded a storm log into the Log 
editor as described above, or optionally, selected one or more storms via the Select menu option. 
(If you've done both, WinStorm will plot from a Select list first.)    To then start the plot, select 
Start from the Plot menu.    To control plot characteristics, such as the symbols used to mark the 
path of the storm, line widths, delays between points, etc, use the Preferences menu.    

Each of the above options is further described in other sections of this help file.



Registration
This software is distributed as shareware.    As such, you are encouraged to register your copy by 
printing the REGISTER.TXT file provided with the software, completing it, and mailing it to the 
address listed below.    Registration costs $20.00.    This will entitle you to:

o    Prompt notification of future program enhancements and bug fixes. 
o    A diskette containing all storm tracks for 1886 through 1991.
o    Help and technical support.

 You may also freely distribute copies of this software.    If you do so, make sure to include all of 
the files that were included with the copy you received.    Distribution is most easily accomplished
by providing the original self-extracting file.

This program is Copyright © 1992, David C. Ingram. The author makes no warranties or 
guarantees for this software.    The author assumes no liability in any way for your usage of this 
program, and is not responsible for any consequential damage that might arise from that usage.   

In case you have need of additional assistance, please call  (713) 488-2578, or write to the 
following address:

Ingramation
Suite 349

2437 Bay Area Blvd.
Houston, TX    77058



File Menu
The file menu is used to open an existing storm log, create a new one, save one that you are 
currently editing, or exit the program altogether.

New Used to start a new storm log.    

Open Used to open an existing storm log.    

Save Save is used to save a log that was previously opened.

Save As Save As is used to save a log that was just created and has not yet been
saved.

Exit Exits the program.



File New
File New clears out the storm log and activates the Log editor so that you can begin a new storm. 
If you have made changes to a storm but haven't yet saved them, you will be prompted to save 
changes before the log is cleared out.I



File Open
File Open is used to open an existing storm log.    File Open invokes a dialog box, similar to that 
found in most Windows programs, for use in selecting a disk, directory and file.    

To open a storm log:

1.    Select the disk and/or directory you desire by clicking on a drive or directory in the Directory
          list box and pressing OK, or alternately, double-clicking on the drive or directory.
2.    Type the name of the storm log you wish to open, or select it in the Files list box.
3.    Click OK, or double-click the storm name

Note that since the file name may not necessarily correspond to the name of the storm you wish 
to edit, you may click on a file name to display the storm name for a log on screen, next to the 
label Storm Name.



File Save
Saves a file that was previously opened back to the original file.    This option is only available if 
the storm was previously saved, otherwise it is disabled.



File Save As ...
Invokes the File Save As dialog box so that you may specify a file name for saving the file that is 
currently in the Log editor.    

To save a storm log:

1.    Select the disk and/or directory you desire by clicking on a drive or directory in the Directory
          list box and pressing OK, or alternately, double-clicking on the drive or directory.    You may
          also type the path for the file in the Filename Edit box.
2.    Type the name of the storm log you wish to save, or select it in the Files list box.
3.    Click OK to save the file.

If the filename already exists, you will be prompted to choose whether to overlay the existing file.



File Exit
File exit quits the program.    If unsaved changes exist, WinStorm will prompt you to save changes
prior to exiting.



Preferences
Use the preferences dialog to control the behavior of WinStorm.    Preferences are such things as 
what time zone is used for displaying time, whether or not lines are drawn between points as 
they are plotted, or the delays that are inserted between storm points during a plot.    The various
preference settings are grouped according to purpose.    The various groupings are listed below:

Path Markers Determines what graphical symbol is used to mark the path of a
hurricane as it is being plotted.

File Selection This is the default file extension that is assumed for purposes of
building the storm select list.

Time Zone Selects from 4 different time zones; Eastern, Central, Mountain, and
Pacific.

Pressure Determines what units are used for displaying barometric pressure;
millibars or inches.

Warnings Warnings is used to have the program warn you when the storm is
within a specified range.

Animation Controls certain behaviors for the plot function.

Save Preferences Saves the preference values when the program is exited.



Path Markers
Path markers are the little symbols that are left behind to mark each set of latitude and longitude 
coordinates that comprise the storms "official" track.    You have four options to choose from:

No Path Marker Select this option if you do NOT want each storm point to be marked.

Points Select this option to have solid circles used as path markers.    You
may optionally set the size of the circles using the point size scroll bar.

Symbols Select this option to use storm symbols as the storm path marker.

Image Select this option to use the same storm icon that advances during a
plot as the path marker.

If you choose to use Symbols as the path marker, you may also choose to have the Symbols 
colored in to reflect the intensity of the storm.    If so, check the box beside the label "Color 
Marker by Intensity".    Green indicates that the storm is not yet of tropical storm force (39 mph), 
yellow indicates that the storm is not yet a hurricane (74 mph), and red indicates that the storm 
has become a full blown hurricane. 

If you would like to have lines drawn between the points as the storm progresses, check the lines 
box.    You may also set the thickness for the lines using the line thickness scroll bar



File Selection
The File Selection section of Preferences lets you choose the default file extension that is used 
whenever WinStorm needs to search for storm files.    This occurs in two places; whenever the File
Save or File Open dialog boxes are presented, and whenever the index of files used by Select is 
built.    The latter is really the most important use of the default file extension since, unlike with 
the File Open/Save dialogs, there is no facility to specify a different file extension.

The default extension is up to 3 characters, and may include the standard DOS wildcard 
characters such as * and ?.



Time Zone
Time zones in WinStorm refer to the standard definition of time zone, where Eastern Standard 
Time (EST) is 5 hours less than Greenwich Mean Time, Central Standard Time (CST) is 6 hours 
less, and so on.    WinStorm provides for use of Eastern, Central, Mountain (MST), and Pacific (PST)
times.    

Most users will set this to their own time zone.    However, if you normally get hurricane track 
updates for a different time zone, you might choose to make that time zone the default.    For 
example, if you live in Houston TX, in the Central Time Zone, and for some reason get your storm 
updates in Eastern Standard Time format, you might choose to set this option to EST.    



Pressure
Pressure, or Barometric Pressure, is generally expressed in either of two ways; millibars and 
inches.    The former is more prevalent with "official" weather services, although many television 
and radio stations report barometric pressure in inches.    

You should set this value to whatever you prefer.    The whole point of saving it is so that you can 
observe the relative change in wind pressure that occurs as a storm strengthens.    With this in 
mind, either unit will do.    It is important to note that WinStorm automatically converts the value 
that is entered to the unit that you select here.    Valid values for barometric pressure are 25 to 32
inches, or 846 to 1084 millibars.



Warnings
The warnings option allows you to set an automatically triggered warning message to occur 
whenever a storm that is being plotted comes within a specified number of miles of the Warning 
City.    All of the warning options are activated by clicking the Warn At checkbox within the 
Warnings group.

The Warning City is chosen from the pull down list of cities on the Preferences dialog, by    first 
clicking on the down arrow beside the list box, then clicking on the desired city.    The number of 
miles for the warning is set using the scroll bars beside the Warn At edit box.



Animation
The animation controls let you control the behavior of the plot function.    Here you can set a 
delay between points as they are plotted, a delay and/or pause between storms when multiple 
storms are being plotted from a select list, and a delay between plots when you want to 
continuously plot from the storm log or a select list.    You may also choose to have the storm 
centered on the screen as it is being plotted.    This is an especially valuable feature when a storm
begins on one edge of the map and ends on the other.

Delay values are in 1/1000's of a second, with the exception of the continuous plot feature which 
is in increments of 10 seconds.    You set the desired values using the scroll bars that are provided
alongside each check box.    Note that the scroll bars only become active if you have checked the 
corresponding check box.



Save Preferences
Check this option if you want any changes you have made to preferences to be saved to disk 
when you exit.    



Log
The Log option invokes the log editor.    Log is only available if you have selected File New, to start
a new storm log, or loaded an existing storm log, such as through File Open.    The Log editor itself
is made up of two different dialogs;    a tabular listing of storm records, and a single record dialog 
for use in editing a storm record.    The single record dialog is invoked by clicking the Add or 
Change buttons.

Add Used to add a record to a storm log.

Change Used to change a record in a storm log.

Delete Used to remove a storm record from a storm log.

Name Used to name a new storm log or change the name of an existing storm log.

To exit the edit dialog without saving, click Cancel or press Escape.    To exit the Log editor 
altogether, first dismiss the edit dialog by either saving or canceling the current operation.    Then
click the Close button or press Escape.    The log will not be saved until you explicitly save it with 
File Save or Save As.    If you attempt to exit WinStorm without first saving changes you have 
made, WinStorm will prompt you to save before exiting.



To Add A Storm Record

Click the Add button to invoke the edit dialog.    Then, enter data into each field, tabbing if 
necessary to advance the caret.    When done, click OK.    Note that each record must be unique.    
Also, legal values for date, time, latitude and longitude are required before a log record may be 
successfully stored.    Legal values for dates are any valid date from 1800 to the present and 
beyond.    Times are expressed in "military" time.    Latitude may range from 0 to 60, 
Longitude from 10 to 120.    Highlighting a record from the list before clicking Add will pre-fill the 
edit dialog with the values in the highlighted record.



To Change A Storm Record

Highlight the record to be changed, then click the Change button to invoke the edit dialog.    Note 
that you may also double click the record to be changed.    When done, click OK to store the 
record.    Note that each record must be unique.    Also, legal values for date, time, latitude and 
longitude are required before a log record may be successfully stored.    Legal values for dates are
any valid date from 1800 to the present and beyond.    Times are expressed in "military" time.    
Latitude may range from 0 to 60, Longitude from 10 to 120. 



To Delete A Storm Record
Highlight the record to be deleted, then click the Delete button.    Note that there's no way to 
recover a record once deleted!



To Change The Name Of A Storm
Click the Name button, then enter the new name in the Storm Name field.    Names may be up to 
16 characters in length, and may contain spaces.



Select
Select invokes the Select dialog, which is used to create a select list of storms for use in plotting 
multiple storms in sequence.    Select provides facilities for screening the storm list by date range 
and storm intensity, as well as changing it's order.    

Screening by date range Use the date screening controls to limit the number of storms
that appear in the storm list.

Screening by storm intensity Use the checkboxes for storm intensity and category to limit the
number of storms that appear in the storm list.

Re-ordering the storm list Use the radio buttons at the bottom of Select to affect how the
storm list is sorted.

All options within the Select dialog take effect immediately upon entering a valid value.    



Screening by Date 
The upper part of the Select dialog is used to narrow the list of storms in the Storms list by date.   
The first line is used to select a master range of storms.    For example, entering 05/05/80 into the
From field, and 09/30/85 in the To field, would produce a list of all storms from May 5, 1980 
through September 30, 1985 in the Storms list box.    This assumes, of course, that you have 
previously selected the 1980 decade from the Directories list.    Null values in either From or To 
imply infinity.

The second line, labeled Subrange, is used to specify a recurring range that is applied against 
every year of the master range, described above.    Still using the previous example, entering 
05/01 in the From field and 06/30 into the To field would produce a list of storms that include all 
storms between May 1 and June 30 for every year in the range May 5, 1980 through September 
30, 1985.    Note that for 1980, any storms that occurred during the period May 1 through May 4 
would be excluded, since the master range began on May 5.    Null values in either From or To 
imply infinity.



Screening by Storm Intensity
This section of Select includes the two control groups, labeled Storm Intensity and Category, and 
allow you to screen the storm list by storm intensity.    The Storm Intensity group lets you specify 
the maximum classification (e.g., Hurricane, Tropical Storm, etc.) the storm achieved during its 
existence.    The Category group supplements the previous group in allowing you to screen storms
which reached hurricane force by storm category.    The categories are based on the 
Saffir/Simpson scale and range from 1 to 5 as follows:

Category Impact

1 Maximum winds of 74-95 mph, storm surge of 4-5 feet above sea level.
2 Maximum winds of 96-110 mph, storm surge of 6-8 feet above sea level.
3 Maximum winds of 111-130 mph, storm surge of 9-13 feet above sea level.
4 Maximum winds of 131-155 mph, storm surge of 13-18 feet above sea level.
5 Maximum winds of greater than 155 mph, with storm surge greater than 18 feet

above sea level.



Specifying Sort Order
At the bottom of the Select dialog are two groups of radio buttons for use in specifying the sort 
order for storms in the Storm list.    The topmost group lets you select either a Name/Date 
sequence, or a Date/Name sequence.    The bottom group lets you choose either an Ascending or 
Descending sort.    Simply click on the radio buttons in either group to automatically change the 
sort order in the Storm list.



The Storm List
When WinStorm is installed, subdirectories are created for every decade in the period 1886 to 
1991.    In each of these subdirectories are placed the historical storm data files provided with the 
program.    In standard Windows fashion, you may view the contents of any of these 
subdirectories by double-clicking on the decade (subdirectory) of interest in the Directories list.    
Valid storm files which match the file selection criteria specified in Prefs will then appear in the 
Storms list.    Subdirectories that you add, as well as any valid storm files that you create and/or 
store in them, may appear in the Storms list.

The purpose of the Storms list is to provide you with a list of storms from which you may select 
one or more for plotting.    Selection is accomplished as follows:

To select a single storm Click on the desired storm.
To select a range of storms Click on the first storm in the range, and drag the

mouse cursor to the last storm in the range.    Release
the mouse.

To select non-contiguous storms Click on the first desired storm, then, holding the
Control key down, continue clicking on all additional
desired storms.

To accept your selections, click OK.    The storms you highlighted now constitute a "select list".    To
clear any selections you have made, click on the Clear button at the right of the dialog.    To 
refresh the list, such as when you have added storm files to the current directory outside of 
WinStorm, click the Refresh button.    .    Press Escape to exit the Select dialog without making any
changes.

If you have made a selection from the Storms list and clicked OK to exit the dialog, all future plots
that you start from the Plot menu will include only the storms you selected.    In other words, if 
storms have been selected, WinStorm will plot from this list rather than from the Log editor.



Plot
The Plot menu is used to initiate and control storm plots, as well as to open any of 3 special 
purpose dialogs that provide added control and/or information while a storm is plotting.

Start Initiates a plot.    

Stop Ends an active plot.

Refresh Loads a clean copy of the map.

Control Panel Dialog Control Panel provides on screen data as well as an alternate
set of controls for use during a plot.

Wind/Pressure Dialog Wind/Pressure provides a graphical perspective on wind
speed and barometric pressure.

Notes Dialog Notes are for displaying ad hoc information that you have
chosen to save with your storm log data.

Animate Causes the plot to be drawn automatically.



Starting a Plot

To plot a storm or a group of storms, you must have first created a storm in the Log editor, loaded
an existing storm into the Log editor, or created a select list of one or more storms using Select.    
When you are then ready to plot, there are two ways to begin.    First, there is the Start option on 
the Plot menu.    Simply click this option to plot the first point.    Or, if you have opened the Control
Panel dialog, there s a Start button there which performs the same function as the Start option on
the Plot menu.    

Having started a plot, the next step is plotting all subsequent points that belong to the storm 
track.    The Next option on the main menu, and the Next button on the Control Panel will plot the 
next and all subsequent points by repeatedly clicking them.    Note that if Animate has been 
checked, all remaining storm track points will be plotted automatically, subject to the timing 
options you have selected under Prefs.



Stopping a Plot
Stop allows you to end and active Plot.    There are several reasons why you might wish to stop a 
plot.    First, whenever a plot is active, some menu options are disabled to protect the integrity of 
the current plot.    If you wish to access these disabled features, you must end the current plot.    
Secondly, if an animated plot is in progress and you wish to stop it, the Stop option provides you 
with this capability.    Stop is available on the Plot menu, and also as a button on the Control 
Panel.



Refresh the Map
The Refresh option loads a clean copy of the map in from disk.    All previously plotted information
is effectively lost.    Note that this may take a few seconds since the map is fairly large.    Refresh 
is available from the Plot menu and also from the Control Panel.



Animating a Plot
A plot may be animated such that you don't have to click Next to view each successive point in a 
storm track plot.    To do this, click Animate on the Plot menu, or at the bottom of the Control 
Panel dialog.    The Animate options are available at all times and take effect immediately.    Note 
that if you select Animate when a plot is active, the Next button will change to Continue.    Once 
you click Continue to resume the plot, the plot will be animated.



Control Panel Dialog
The Control Panel dialog provides you with two important capabilities, including the ability to view
storm track data during a storm plot, as well as a set of plot controls to prevent having to pull 
down the Plot menu every time you wish to affect the storm plot.

The Control Panel may be moved anywhere on screen.    It may also be closed by clicking the 
Close button, and by double-clicking the control box in the upper left-hand corner.



Wind/Pressure Dialog

The Wind/Pressure dialog provides you with a graphical way of viewing the relationship between 
wind speed and barometric pressure.    You need only open this window, the plotting is handled 
automatically using the data that is part of the storm log.    Note that missing data will skew the 
plot and obscure its meaning.    

Wind Speed is plotted against the Y1 axis on the left side of the dialog.    Pressure is plotted 
against the Y2 axis on the right.    Both Y axes use the min and max values contained within the 
storm log.    The X axis represents the time range between the first and last storm points in the 
log.    

One final note:    There have been a few problems with the Wind/Pressure dialog with some low-
end super VGA cards.    These problems do not seem to affect other parts of WinStorm, jus the 
Wind/Pressure dialog.



Notes Dialog
The Notes dialog is used to display notes while plotting.    Notes are free-form comments that you 
enter via the Log editor for the purpose of annotating the formal storm track data.    Example uses
of notes might be to describe current forecast information or to record surrounding weather 
conditions.



Next/Continue/Pause
When you first start WinStorm, there is a menu option named Next.    This option is provided so 
that you may conveniently advance a storm plot by clicking on the menu bar as opposed to 
pulling down a menu.    If the plot is animated, that is, Animate has been selected, Next is 
changed to Continue or Pause.    Continue is used to indicate that an animated track is paused, 
and may be restarted by clicking Continue.    On the other hand, while an animated track is 
actually being plotted, Continue is changed to Pause to provide a way for temporarily pause the 
plot. 

The above is also true for the Next button that is part of the Control Panel Dialog. 



Shrink

Shrink lets you view the entire map at once.    This way, if you've plotted a whole slew of storms 
for a particular time period, you can view the overall storm pattern that existed for that period.    
Shrink is kind of slow, since it actually compresses the larger map into one that fits neatly on a 
single screen.    For that reason, Shrink is also limited to viewing the map only after a plot has 
completed.    Nor can you initiate a plot while the screen is shrunk.



Creating A Storm Log

To create a storm log:

1.    Click File on the menu bar to pull down the File menu.
2.    Click New on the File menu.
3.    Click Log on the menu bar, to open the Log editor.
4.    Click the Add button to invoke the single record edit dialog.
5.    Enter data for the fields on the single record edit dialog.    Only the first 4 fields are required.
6.    Click OK to save, or Cancel to throw away changes to this record.
7.    Repeat steps 4 - 6 until you have added all the data you wish to add.
8.    Click the Name button to name the storm.    Click OK when done.
9.    Click the Close button the close the Log editor.



Editing An Existing Storm Log
To edit an existing storm log:

1.    Click File on the menu bar to pull down the File menu.
2.    Click Open on the File menu.
3.    Select the directory and file that you wish to edit, and click OK to open the file.
4.    Click Log on the menu bar, to open the Log editor.
5.    Highlight the record you wish to change, and click the Change button.    Alternately, double-
click
          on the record to be changed.
6.    Change the data you wish to change, then click OK to save the record or Cancel to throw 
away
          changes.
7.    Click the Close button the close the Log editor.



Saving A Storm Log

To save a Storm Log to disk:

1.    Click File on the menu bar to pull down the File menu.
2.    Click Save or Save As... on the File menu.    If the file was previously saved, Save will cause 
the
          file to be saved to the original file name.
3.    If the file hasn't been previously saved, or if you chose Save As..., you will see the File Save
          dialog.
4.    Select a disk and directory from the Directory list box.    
5.    Type the name of the storm file in the Filename edit box.
6.    Click OK to save the file, or Cancel to discontinue the save operation.



Plot From The Currently Open Storm Log

To plot from the currently open storm log:

1.    Make sure that you don't have any storms selected under Select.    Choose select and scan 
          the Storms list to make sure none are selected.    If any are, click the Clear button, then click 
OK.
2.    Pull down the Plot menu by clicking Plot on the menu bar.
3.    Click Start to begin the plot.
4.    Click Next on the menu bar to plot each successive point.
5.    Number 4, above is not necessary if Animate has been selected.



Plot From The Current Select List
To plot from the current select list:

1.    Make sure that you have created a "select list" by    highlighting storms in the Select dialog
          Storm List and clicking OK.
2.    Pull down the Plot menu by clicking Plot on the menu bar.
3.    Click Start to begin the plot.
4.    Click Next on the menu bar to plot each successive point.
5.    Number 4, above is not necessary if Animate has been selected.



Change The Name Of A Storm
To change the name of an existing storm:

1.    Click File on the menu bar to pull down the File menu.
2.    Click Open on the File menu.
3.    Select the directory and file that you wish to edit, and click OK to open the file.
4.    Click Log on the menu bar, to open the Log editor.
5.    Click the Name button to bring up the Name dialog.
6.    Enter the name you desire and click OK.
7.    Click the Close button to close the Log editor.



Create A Storm Select List
To create a select list of storms:

1.    Click the Select option on the menu bar.
2.    Fill the Storm List box by double-clicking on a subdirectory that contains storm files in the
          Directories list.
3.    Select storms in the Storm List by highlighting the ones you wish to plot.
4.    Click OK.



Design Notes
I originally designed WinStorm to cope with the most basic functions required for tracking a 
hurricane.    That is, to store the data that describes a hurricane track and to plot that track on an 
electronic map.    I was hoping to create a tool that would let me plot storms over and over 
without the hassle of having to draw the storms manually on a wall chart, while also enhancing 
the precision at which these plots were drawn. I also wanted something that would let me play 
"what-if" games on the data.    I believe WinStorm meets these objectives.    

As I busied myself with the design, coding, testing and debugging of WinStorm, I constantly found
requirements for more features that were both functional as well as personally appealing.    When 
I previewed the program to friends, even more requirements emerged.    Most of these found their
way into WinStorm, some remain on the to do list, and the rest have a home in the bit-bucket.    
For a short review of the evolution of WinStorm features, read on.    Might help if you're looking for
different ways of using the program.

Why the storm log?    Well, early intentions would have had me developing a database feature 
that would effectively keep all storm data in one big structure.    That is, you wouldn't have a 
bunch of storm files, but rather a collection of data and index files that comprised a storm 
database.    This definitely has its advantages, most importantly the ability to interleave the plot 
of multiple storms to create a more realistic sequence than plotting storms serially.    But that's 
about all it seemed to buy me, along with a lot more work, and the downsides were more weighty.
For example, drop a few bits in a structure such as the above and you could lose your entire 
storm database.    That's a big negative.    You also lose the ability to pass storms around to others
you know who track them.    Since flexibility was of key importance and this last requirement was 
important to me, I opted for individual files.

Select was an original feature that was intended to provide a simple way for the user to screen 
the monster list of storms to get to those in a particular date range that might be of interest.    
Storm magnitude was also to    be included.    Once I started playing with my early prototypes, 
however, I discovered a need to plot, say, all (and only) June storms through a 5 year period.    
The original function of the date screening controls fell short of this.    What I needed was a range 
within a range.    The Sub Range below the From and To date edit controls was the result.    
Likewise, the checkboxes for hurricane category were added after the initial design to provide 
screening based on hurricane intensity.    Ever want to see all the category 5 hurricanes that 
occurred between September 1 and September 10?    Now you have a way to do this.

One aspect of Select probably deserves some explanation, specifically, the fact that I split the 
historical storms up by decade.    Sure, there isn't any magical correlation of storm behaviours by 
decade, but there is a very real performance reason for doing it this way.    Since Select lets you 
change the screening and ordering criteria for the storm list, he obviously needs to maintain an 
index in memory so that such changes can be reflected very rapidly.    It's because of the size of 
this list and the fact that storms are maintained as separate files that I split things up this way.    
In other words, since he has to read the header from each storm file to get the index information, 
then sort the index using both a date and string field, this process can be very expensive in 
machine time and user patience.    But, but, but ... If you really feel the urge, you can move all of 
the storm files into a single directory.    The program will handle up to 1024 storms.    Be 
forewarned, though, that a read and sort can take quite a bit of time.    I plan to address this in 
version 2.

The Plot feature was also the subject of many design iterations, although in this case I think they 
were all for the better.    The biggest challenge here was in creating    an interface that    was 
obvious and at the same time a bit sophisticated.    The result was the Control Panel, which 
addressed my wants for on screen storm data as well as plot controls.    Since screen real estate is



somewhat limited, I opted to combine the two, but in such a way that you could hide one part or 
the other by shoving one part off of the visible screen.

I had other great things in mind for Plot, but managed to talk myself out of some of them.    
Originally, I planned to show the wind fields for a storm as a group of concentric rings that were 
filled with different colors.    I may still add this one in the future, but basically dropped it since 
any (real) representation must take into account the fact that storms aren't perfect circles and 
that wind fields aren't necessarily consistent among storms of the same intensities.    Too many 
variables.      Another of the would-be features was a projected track function.    This would 
actually be quite easy to implement, but I was concerned that folks might actually take the 
projection too seriously.    After all, projecting a storms future track based on where has been is an
absurd notion at best, and potentially deadly at the worst.    Hurricane prediction is what we pay 
the folks in Miami to do.

While drawing storm tracks and displaying storm information    is definitely a good start,    one 
interesting feature was added toward the end of the development in the form of the 
Wind/Pressure dialog.    Contemplated very early on in the design phase but discarded as rating 
little value beyond novelty, Wind/Pressure almost didn't make the final cut.    Naturally, it took 
someone else asking for it to get it in.    Yet another late addition has probably become my 
favorite; the Auto Center option under preferences.    Had someone not pointed out the folly of 
trying to keep up with an advancing plot using only the scroll bars, Auto Center would likely be 
keeping company with Wind/Pressure in the bit bucket.

Since I wanted a tool to replace my tried and true manual methods for monitoring hurricanes, I 
also had to face the issue of what to do with all the notes, scribbles, etc., that I accumulate in my 
hardcopy storm log during hurricane season.    That is, if WinStorm was to really offer a complete 
alternative to the old way of doing things, I had to build in some provision for storing literal data 
and displaying it with each storm point.    Hence, the Notes dialog was born.    I hope the 300 
character limit (approximate) isn't a problem ... I had to draw the line somewhere, and those log 
files can get big quickly with very many notes.

Now for the future.    Many folks who saw the protos have already pointed out the absence of a 
print function.    I honestly didn't see the need for one, since you can regenerate a plot whenever 
you want to, or print via clipboard and paintbrush, but I've been asked enough that I'll definitely 
add one.    (Sorry trees!)    Select also needs the ability to screen for storms that pass within a user
specified region.    That is, if you want to see all storms whose tracks passed through a particular 
spot on the map, I plan on giving you a way to do that.    It may take some horsepower though, so
don't get too excited unless you're driving at least a 25 MHz 386.    (A math co-processor would 
certainly help.)    

Want clipboard support?    The ability to save the map to a BMP file?    These will likely be included
in the next release.    Although I personally don't see a need to load an alternate map, I'm sure 
someone will point this out to me if a need does truly exist.    Also, in spite of the wonderful role 
that Control Panel plays, WinStorm still lacks the ability to associate a file and/or storm name with
a track that has been plotted on the map.    Once you've drawn a bunch of storms, you have no 
way to look at the map and determine which track belongs to which storm.    This I plan to correct 
in two ways.    First, I'll provide a way to annotate the map with a name and/or number.    
Secondly, I plan on adding a plot history dialog that makes the association between a storm/file 
name and number.    From this dialog, you'll be able to re-plot the storm and enter the log editor.   

Finally, Microsoft, in its infinite wisdom, sufficiently screwed around with Windows 3.1 such that 
my latitude and longitude lines have little tick marks in them.    Beats me how this happens, 
unless they've actually replaced the API call (bad idea!).    Nothing else seems to be broken, but 
let me know if you find anything.    Until I get a good feeling that most folks have upgraded to 3.1,
I don't plan to recompile WinStorm for it.    (Read that:    I don't want to maintain 2 different 



versions.)    I don't see this happening in the near future. In case you have OS2 2.0, I've found no 
problems there whatsoever.

Happy storm tracking!! 
          

Dave Ingram


